
Morpheus Photo Warper™

Reviewer’s Guide
Morpheus Photo Warper is easy-to-use picture distortion software 
that warps and exaggerates portions of photos such as body parts!

Have you ever wanted to distort a picture to make someone look completely different? Use Morpheus 
Photo Warper to exaggerate physical features of friends, family, celebrities, politicians, pets - anyone or 
anything. Amaze your friends and loved ones with hilarious warps and picture distortions you can email to 
them in seconds!

Included in the Reviewer’s Guide:

• Screenshots
• Tutorial
• FAQ

Tutorial

Loading Pictures

 Start Morpheus Photo Warper by clicking on the 
icon, either on your desktop, or in the Start menu. If 
you are in the right program, the corner of the 
screen should resemble this picture. 

Screenshots



You should see the Layout Wizard when you first start Morpheus 
Photo Warper. If it has been disabled, it can be accessed from the 
File menu. Select "Create a new warp layout,"  then press the Next 
button to continue.
 
The "Use beginner mode menus" checkbox is checked by default.
This hides some of the more advanced menu options and toolbar 
buttons and retains only the basic buttons needed to familiarize 
yourself with the software. Checking normal mode menus gives you 
access to all of the available features. 

On the second page of the wizard, you will load the picture you wish 
to use in your warp. Click the Load Picture button above the picture 
preview box to select your picture file. 

Adding Dots

In this example, the "black dress.jpg" sample image (included with 
Morpheus Photo Warper) will serve as the picture to be warped. 
Once the file is selected and opened, the picture will appear in the 
picture preview box below the Load Picture button. 

Once you have loaded your picture, click the Next button again. On 
the final page of the wizard are some basic instructions for getting 
started. Once  you click the Finish button, the directions from the last 
page of the wizard will still be shown in a small pane off to the side. 

Once you finish the Layout Wizard you will be brought into 
Morpheus Photo Warper with a new layout containing your picture 
similar to what is shown here. At first glance, it looks like the same 
picture is loaded twice into two different windows, but in reality the 
picture you selected is only loaded into the picture window labeled 
Start. The picture window labeled End is an editable preview of the 
final frame of your warp which will change as you proceed with the 
rest of the steps.  

The next step in creating your warp is to place dots in both of the 
picture windows in order to define how the warp will animate. First, 
you must select the Add Dots tool from the toolbar with the list of 
various tools on it as shown here. 



In this example, we'll start by placing a dot near the edge of the arm 
in the starting picture window, because we plan on creating a warp 
which changes the size of her arm. Simply click on the picture to add 
a new dot.

Notice that a corresponding "partner" dot will appear automatically in 
the opposite picture window, for every dot that you add to a picture. 

Here we have added three more dots around the arm. The more 
dots you use, the better your resulting warp will be.
 
The most recently added dot will glow with a colorful outline, and its 
partner dot will glow with a black and white outline. This lets you see 
where the dots have been added. Notice how the partner dots 
appear in the same location on the ending picture as they do in the 
starting picture window. These partner dots will need to be adjusted 
so that they change the look of the ending picture to represent how 
you want the last frame of your warp to look. 

 In order to align the dots you must select the Move Dots tool as 
shown here. This tool allows you to click and drag dots around in any 
of the picture windows. 

 We want to adjust the dots in the picture window labeled End until 
they represent how you want the last frame of your warp animation 
to look. When you hover over a dot, you should notice that it glows 
with a colorful outline, and its partner dot glows with a black and 
white outline. Simply click on the dot, hold the mouse button down, 
drag the dot to a new location, and then release the mouse button. 

 Here we have moved the red dot inward somewhat in order to make 
the arm appear smaller. Notice that the ending picture updates itself 
automatically as you move the dot, to show you what the final frame 
of your warp will look like. 

Aligning Partner Dots



Move the other three dots in the same fashion as the first one. 
You can see here how we adjusted all of the dots to try to keep the 
same relative shape of the arm while making it smaller.  

Here we have added a total of 21 dots to the warp and are ready to 
render it to a file for use outside of Morpheus Photo Warper. 
The layout in this final form is available to play around with since it is 
included as one of the sample layouts with Morpheus Photo Warper. 

The Preview window is located on the right side of the screen by 
default. It can be hidden and shown by pressing Ctrl+P in order to 
give yourself more room while working on the dots in the picture 
windows. The Preview window shows one frame of your animation at 
a time. You can view different frames of your animation by dragging 
the track bar left and right. 

Previewing the Warp

Rendering the Warp

Press the Play button to see your warp in action . This will play your 
animation in real time right inside of the Preview window.
To see this example playing in the Preview window, visit this link and 
scroll down to the bottom of the page:

http://www.morpheussoftware.net/morpheuswarp/tutorial/warp4.php

You can see how the arm shrinks with just the four dots we've placed 
while the rest of the picture stays pretty still. If you want an even 
better warp, simply add a few more dots around other parts of the 
picture to warp more key picture elements.

To render your warp, press the Render Timeline button on the 
toolbar. The button to the left is the Save Layout button.

Rendering is different than saving your layout. Saving creates a file that can be edited later on. Rendering creates 
a file which can be emailed or displayed in other programs, but it cannot be changed by Morpheus Photo Warper.  



At the Save As window, you can select a location to render your 
warp to, enter a name for the file, and select a file type to render to. 
Enter any file name you wish, but make sure you remember which 
folder on your hard drive you saved your warp into. 

Key frames define midpoints in your warp, allowing the dots to move 
in a defined path as they transition from the starting picture to the 
ending picture. Normally, the dots would move in a straight line. 

The quickest way to add a key frame is to make sure Preview All 
Frames is enabled in the Timeline window. Click on any of the frame 
thumbnail buttons to select it, then press the Make Key Frame 
button. A key frame will be made at that point in the warp.

Key frames are defined at certain percentage points in the warp and 
are not tied to specific frames in the timeline. This example key 
frame was created at the 66.67% point in the warp.
 
Double click on the key frame button in the Timeline window and a 
new window will appear, allowing you to adjust the dots for that key 
frame. 

Key frames are an optional step you can use to improve the look of 
your warp. This is an advanced feature which requires Morpheus 
Photo Warper Professional
 
For this example, we are starting with a different warp, as pictured 
here. This layout is included with Morpheus Photo Warper.
 

(Pro) Using Key Frames

Flash SWF and Animated GIF formats are the best for displaying on 
webpages. Here we will render to a Flash SWF movie by selecting 
Flash SWF from the "Save as type" dropdown.
 
After a brief rendering progress window, your warp file will be 
created and ready for viewing.  To see it in action, visit this link and 
scroll down the page:

http://www.morpheussoftware.net/morpheuswarp/tutorial/warp5.php



The key frame windows work just like the picture windows. The dots 
have multiple partner dots instead of just one partner dot now. The 
number of partner dots each dot has will be one more than the 
number of key frames in that warp. 

When you move the dots in the key frame window, the picture will be 
updated to show you what the warp will look like at that percentage 
point. This is very similar to how the ending picture window updates 
as well.
 
Now the warp will transition from the starting picture to this key frame 
before completing the transition to the ending picture.

FAQ

1. What is Morpheus Photo Warper?
Morpheus Photo Warper is an award-winning graphics program that lets you create animations of photos being 
warped and distorted. Morpheus Photo Warper v3.00 lets you create warps in Flash SWF, Animated GIF, AVI, 
JPEG, PNG, TIFF, and other popular formats. It is easy, fast, and fun to use for both beginning and advanced 
users.

 2. How do I get started using Morpheus Photo Warper?
You can view the tutorial first or just start using the program with the sample warps. Morpheus Photo Warper has 
an intuitive interface that’s easy to learn. We recommend using the beginner mode menus option while learning 
the basics of Morpheus Photo Warper. Please see the help files for more detailed information on the program's 
features. Feel free to visit our support forums and we'll do our best to help you understand the program better. 

 3. What are beginner mode menus?
By default, Morpheus Photo Warper uses beginner mode menus, which hides all but the essential menu choices 
needed to create a simple warp. Beginners can use this option to familiarize themselves with the program.
You can use the normal mode menus by unchecking the beginner mode menus checkbox from the layout wizard 
or select this option under the Edit menu. Normal mode will show all advanced menu options that are available. 

4. Why are some of my dots the same color?
In beginner mode, you are fixed with a cycle of 8 basic dot colors. You will inevitably have several dots that are 
the same color. To tell the dots apart and to correctly locate their partner dot, highlight one with your mouse. 
Its partner dot will highlight as well. You can change the color, style, and dot size by selecting Customize Dot's 
Default from the Morph menu.

5. What is the best way to view my warp when I am finished?
When you have finished creating your photo mix you can view it for yourself right inside the program in the 
preview window.  You can render your photo mix to many picture formats such as JPEG, PNG, or TIFF which can 
be viewed in a variety of applications. 



6. What formats can I render my warps in? Which is the best?
Movie Files: These formats save the entire warp as a single animated file.
 
•  Compressed AVI: Use any installed Windows DirectShow or Video for Windows Codec to compress your
   movies for smaller files.
•  Uncompressed AVI: Perfect quality movie, very large, good for importing into movie editing software such as
   Adobe Premiere.
•  Flash SWF: Best for display on webpages, very small and high quality, and supports full translucency.
•  Animated GIF: Good for webpages, every browser can view them, but images are only 256 color, and thus
   limited to lower quality.

Picture Sequences: These formats save each frame of the warp as an individual file. 
•  PNG: Perfect quality images, small file size, and supports full translucency.
•  JPEG: Very small files good for webpages, but quality poor at higher compression
   settings.
•  TIFF: Perfect quality images, large like bitmaps.
•  BMP: Perfect quality shot of every frame, but very large files.
•  TGA: Perfect quality, large, but supports translucency in more programs.
• XPM: Larger than all other formats, but useful for importing to Linux systems.

Which format is best depends on what you want to do with your warp. If you are unsure, you can try each of the 
formats and see how they work with the other programs. While Morpheus Photo Warper can create any of these 
standard file types, not all third party applications will be able to display files in every one of the available formats. 

7. What do I do with my completed warps?
Use your warps to grab people's attention or to have a good time - create web graphics and enhance your web 
site, email warps to friends and family to make them laugh, create a unique online greeting, post your warps on 
the Internet, add more life to your presentations, or use your warps in countless other great ways! 

If your warp is unique and exciting, and you want to share it with other Morpheus Photo Warper users, you might 
consider submitting it to us for display.

8. How can I email my warp to a friend?
You can email your animations using the built-in email feature by selecting "Email your morph to a friend" from the 
Share menu in the program. The Send Morph Wizard will appear, allowing you to fill in your From address and 
any number of recipient addresses. On the last page of the wizard, press the Send button and your email will start 
sending. Please be patient as it sends as large animations may take longer to send.
 
You can also render the timeline to a file of any type and attach that file to an email in your regular email program 
just like you would any other file. It is recommended that you render a file type that is small in size, such as JPEG 
or an AVI compressed with an MPEG-4 codec such as DivX or XviD.

9. How do I distort a picture of somebody?
Creating an animation which distorts a picture of a person is called a warp, and warping is exactly what Morpheus 
Photo Warper is designed to do. Please see the tutorial for step-by-step directions on creating a warp. 

10. Why do my pictures look squished in the Preview window?
Morpheus Photo Warper automatically sizes your timeline based on the sizes of the pictures you load. It is not a 
problem to load pictures with different dimensions, but if you load two pictures with different aspect ratios, or 
manually set a different size for your timeline, then some pictures may look squished in the Preview window. 
Morpheus Photo Warper will stretch all pictures to fill the timeline size and since it does not cut off any of the 
edges of the pictures, some may appear squished vertically or horizontally in order to fit. 
It is recommended to use pictures of similar aspect ratios by cropping them to the portions you want.



11. What are the best size pictures to use?
We recommend using the largest dimensions you can, since you can more easily place dots at precise locations. 
Keep in mind the aspect ratio of your pictures. If, for example, one picture is 1000x1000 pixels, but another is 
1000x800 pixels, then the second picture may look distorted, since the picture must be stretched in order to 
match the aspect ratio of the other picture. Larger picture dimensions also allow for more clarity when parts of 
your warp are stretched larger.  

12. Can I add dots to just one picture individually?
Every dot you add to one picture will automatically get a corresponding partner dot on the opposite picture. Dots 
only come in pairs, because the purpose of a dot is to match up key features in each picture to tell Morpheus 
Photo Warper how the starting picture will warp into the ending picture. 

13. I closed the picture windows. How do I get them back?
In the Timeline window, double click on any of the picture thumbnail buttons to open that picture window. 
The warp buttons just above the picture buttons will open both pictures for that warp side by side when double 
clicked. If you do not see the Timeline window, it may be hidden. Select Timeline from the View menu to unhide it.

14. What is the difference between a morph, a warp, and a photo mix?
A morph is an animation of one person transitioning into another. A warp is an animation where one picture is 
stretched or distorted. A photo mix is a still picture which is created using parts taken from two other pictures. 
Morpheus Photo Warper is used to create warps. In order to create morphs, you would need the functionality of 
Morpheus Photo Morpher or Morpheus Photo Animation Suite. In order to create photo mixes, you would need 
the functionality of Morpheus Photo Mixer or Morpheus Photo Animation Suite. 

16. What is a codec and which one should I use?
A codec is a "Compressor / Decompressor" and it is what is used to compress AVI files. Nearly all AVI files are 
compressed, but they do not always use the same codec. In order to play back an AVI, you must have the codec 
installed which was used to compress it, or you will be unable to view it. Morpheus Photo Warper allows you to 
compress AVI files with any codec installed on your system, as well as set the various configuration parameters 
these codecs use. The latest generation of MPEG-4 codecs such as DivX and XviD are recommended because 
of both their small file size and high quality video. You can use any codec you like, though anybody viewing your 
AVI would need to have that same codec installed.

15. How can I use my rendered animated GIF files in PowerPoint?
You can insert your animated GIF files into PowerPoint by selecting Insert / Picture / From File from the menu in 
PowerPoint. Currently, no version of PowerPoint properly plays all animated GIFs like your web browser does. 
What's worse is that PowerPoint from each version of Microsoft Office behaves differently:
 
•  Office 2000 - All animated GIF files will loop forever. There is no way to stop the animation at the end. 
•  Office XP - Animated GIF files which should loop forever will act as they should. For files which are set to play a
   certain number of times, PowerPoint plays the GIF one less time than it should. For files which are set to play
   just once, PowerPoint will play them once and stop as it should. 
•  Office 2003 - Plays animated GIF files similar to Office XP, except that files which are set to play just once
   won’t play at all. They will instead remain on the first frame of the animated, paused forever.
 
If you would like your animated GIF files to play once and stop at the end, the safest way would be to set them to 
be played twice in Morpheus Photo Warper and make sure that you view the slideshow in PowerPoint using 
Office XP or higher. However, it is possible that the next version of Office, after Office 2003, will start playing 
these files correctly, and the same slideshow would thus repeat the animation twice in the future. 
Another thing you may want to do in PowerPoint is have your animation showing the first picture, and have a click 
begin the animation. This can most easily be accomplished by creating two similar slides, where the first slide 
actually uses a still picture, and the next slide has the animated GIF in the same location. If all other text in the 
two slides is the same, the click between the two slides will give the appearance of starting the animation. 



17. How can I make my animation wait at the beginning or the ending longer?
Each warp in your timeline can be set to hold for any duration for the starting and ending pictures. Select Morph 
Options from the Morph menu and enter any number of seconds in either "Time to hold for at start" or "Time to 
hold for at end". You can also set your animation to stay on the last picture forever by setting the "Loop morph" 
setting in the Timeline Options to "Stop after the first time." 

18. How can I make my animation play only once instead of repeating forever?
In the Timeline Options window, you can set the "Loop morph" to "Stop after the first time" instead of the default 
of "Loop forever." This will work for Flash SWF as well as animated GIF files. If you render your warp to an AVI 
file, this option has no effect because the AVI file format does not have any way to specify the number of times 
the file should loop. It is up to the program you are viewing the AVI in, such as Windows Media Player, to loop the 
movie or not.
 
In newer versions of Windows Media Player such as 9 or 10, you can simply select Repeat from the Play menu to 
toggle on and off looping the movie file or playing it only once. In Windows Media Player 6.4 there are playback 
options under View / Options where you can adjust the number of times a movie file should loop. 

19. Why does my AVI file go back to the starting picture after the animation plays?
An AVI file has no way to specify what should happen when the movie is finished inside the file itself, so it is up to 
the program you are viewing the AVI with whether or not it should rewind the movie when it is finished playing. In 
new versions of Windows Media Player such as 9 or 10, there is no way to change the default behavior. If the 
Repeat option is off, Windows Media Player will play the movie through once, then automatically rewind it back to 
the first frame and stop. In Windows Media Player 6.4, you can adjust the rewind option by selecting Options from 
the View menu and checking the "Rewind when done playing" option. 

20. How can I keep transparency in my rendered files?
Morpheus Photo Warper by default only renders 24bit truecolor images for each frame, but if you check the 
"Morph the alpha channel" option in the Timeline Options window, then a 32bit image with alpha channel will be 
rendered for each frame. If you wish to keep the entire alpha channel information in tact, you should set the 
"Transparent threshold" to 0. 

The best format for keeping the entire alpha channel in is to render to Flash SWF, which can be set in a web page 
and blend properly using the alpha channel. For animated GIF files, it is recommended to set "Transparent 
threshold" to 128 so that any pixel which is less than 50% transparent will become the single transparent color 
index in the GIF file. If rendering to a series of still images, PNG is the best format for keeping the alpha channel 
in tact, and with the proper web page, it can be shown in all major web browsers and blended properly with the 
background. 

Uncompressed AVI files will store the alpha channel information in the file, and some codecs for compressed 
AVIs may as well, but most AVI viewers will not use this information. If you are using a movie editing program and 
importing the AVIs for further processing, the alpha channel information may be useful depending on which movie 
editing program you are using. 


